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Introduction 
 
After you have developed a working knowledge of PowerPoint, you can transform the interactivity and 
value of your classroom time with this powerful tool.  In this course, we will discuss and build new skills 
and push your presentations away from static listening activities and into dynamic learning activities. 

Objectives 
 

• Discuss Increasing the levels of Interactivity in the classroom 
• Create Question and Answer Activities 
• Create a Hyperlinked Menu  
• Add menu objects to the Slide Master  
• Animate and hyperlink a series of graphical objects to create “Learning Activities” 

Prerequisites 
 

• You must have a working knowledge of PowerPoint 2000 
• You must be able to create new slides 
• You must be willing to reconsider and/or improve your presentation methods 

 
 

Five Levels of Interactivity 
 

1. The “Banking” Model of Education—Simply create and deliver your presentation.  This is the 
default of most PowerPoint presentations 

2. Presenting AND Assessing your Materials Simultaneously—Divide your content material into 
smaller content units and including periodic reviews to assess the effectiveness of your lecture.  
This gives you the ability to illuminate the areas that the students are not effectively learning. 

3. Deconstructing the Lecture—Create a menu system for your presentation and allow the 
audience to choose the delivery order.  The flexibility will customize your presentation to the 
interests of the audience.  It challenges them to be active participants in the discussion, rather than 
passive listeners. 

4. Turn your “Listeners” into “Explorers”—In this section, you will transform the menu system 
into a series of questions with content material lurking behind each option.  By rephrasing your 
first premises, you will entice the readers/listeners into a higher level of active participation 

5. Beyond “Exploration” to “Activity”—By further engineering your material, you can transform 
the activity from exploration and push it completely into the activity realm.  Your students can 
engage with objects and concepts and each object can lead to series of slides of  
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1. The “Banking” Model of Education 
 
The default for most PowerPoint presentations employs what Paolo Friere (a K-12 Educator from Brazil) 
labeled as the “Banking” Model of Education.   The students (or listeners) are passive receptors of your 
information.  You are a depositor and you deposit your “nuggets” of information into their consciousness.  
Those nuggets increase in value with time and can be eventually transformed into something valuable by 
the students.   
 
This is the simplest usage of PowerPoint.  We created presentations under this model in both the 
Beginning PowerPoint 2000, and Intermediate PowerPoint classes.   
 

 
 
2. Presenting AND Assessing your Materials Simultaneously 
 
The easiest way to increase the interaction with your presentation and materials is by dividing your 
material into smaller pieces.  Use logic to determine a size that is appropriate for your subject.  More 
complex subjects will need smaller “units.”  At the end of each of these “units,” add a single slide that 
asks a question about the most important topics of the unit—and have your students/listeners answer 
them.  If your students/listeners are unclear about any of the ideas or topics of the unit, you can 
immediately clarify these concepts before moving to the next unit.   This process makes it easy for your 
students/listeners to ask questions, and it ensures that your students/listeners are “included” in the 
discussion.   
 
 

 
 
Activity #1 (Question and Answer Activities) 

Part A—Arrange the Elements 
 

1. Open PowerPoint 2000. 

2. Select a Design Template. 

3. Create a Title slide. 

4. In the Title box, type Question and Answer. 

5. In the Subtitle box, type I give you the question, and you give me the answer! 

6. Create a Title Only slide. 

7. In the Title box, type Review Question #1. 

8. Click the Text Box tool in the Drawing Tools bar at the bottom of the screen (see image below).  

Your cursor will change to indicate that you can place a Text Box on the screen. 



Advanced PowerPoint 2000

California State University, Sacramento Page 3 of 11

 

9. Place your cursor in the center of your slide, and left-click and drag a long, rectangular box on the 

screen (see image below). 

 

 
 

10. In the Text Box, type __________________ is the correct term for the energy generated by the 

sun in the Hydrologic Cycle. 

11. Adjust the Font, Font Size and Font Color of the text to fit with your presentation. 

12. Create a second Text box (repeat step 8 and 9). 

13. In the second Text box, type Solar Radiation 
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14. Adjust the Font, Font Size and Font Color of the text to fit with your presentation. 

15. Place your cursor in the top-left corner of the box and hold the left mouse down.   

16. Drag the text box to the appropriate space in the first text box (see image below). 

 

 
 

 
Part B—Animate the Elements   

 
1. On the Review Question #1 slide, select Slide Show >> Custom Animation.   

2. Click the Events tab.  Note: This tab may 

already be selected. 

3. Select the check boxes of the items that you 

want to animate.  In this case, select the 

question and the answer (Text 2, and Text 3).  

Be sure to leave the Text that holds the slide 

Title un-checked (Text 1) so that it will remain 

on the slide. 

4. Select the question text (Text 2).   

5. From the entry animation options, select Fly, From Left with [No Sound].   

6. From the Introduce text Options, select All At Once. 

7. Select the answer text (Text 3). 

For the Macintosh: 
1. Select Slide Show >> Animation >> 

Custom. 
2. Click the button next to the question 

text (Text 2), and select Entry.  This 
will animate the element to “enter” the 
slide upon a click. 

3. On the Effects tab, select Fly from 
Left. 

4. Click the button next to the answer text 
(Text 3), and select Entry. 

5. On the Effects tab, select Dissolve. 
6. On the Order and Timing, and use the 

Up and Down arrows to ensure the 
timing order is correct. 
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8. From the entry animation options, select Dissolve with [No Sound].   

9. From the Introduce text Options, select All At Once. 

10. Click the Order & Timing tab. 

11. Be sure that the Question text is at the top of the list, and that the Answer text comes second.  Use 

the Down and Up arrows to adjust the order (see below).  Also be sure the On mouse click radio 

button is selected, or you will have to rehearse and use the automatic timings 

 

12. Click OK to set your changes. 

13. Switch to Slide Show View, and test your question and answer page. 

 
 
3. Deconstructing the Lecture 
 
In the late 1960’s, the ideas of Jacques Derrida changed the way we think about life.  His theories (called 
Deconstructionism) have been applied to Literature, Language, Philosophy, History, Architecture, the 
Sciences, Education, and Art to name a few.   His most pertinent argument to the presentation of 
materials with PowerPoint would be that when you provide only a single way to view/learn a lecture 
material, you restrict the learning to that single message.  We are going to create a hyperlinked menu 
system for a lecture that will lend flexibility to your materials that can create new and even unforeseen 
learning opportunities.     
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Activity #2 (Planning and Creating the Menu) 
 

1. Open PowerPoint 2000 

2. Select the Blank Presentation radio button, and click OK. 

3. From the New Slide dialogue box, select Title slide and click OK.  Note:  The Title Slide may 

already be selected. 

4. In the Title area, type Earth Systems: The Hydrologic Cycle 

5. In the Subtitle area, type An Interactive Learning Activity 

6. Add a New Slide.   

7. From the New Slide dialogue box, select Bulleted Slide and click OK.   

8. In the Title area of this slide, type The Hydrologic Cycle Components 

9. In the bulleted list, type Gravity  (The energy that causes things to go to lower elevations) 

10. Repeat the process an create bulleted items for the following labels (see below): 

• Solar Radiation (The energy source for Evaporation) 
• Evaporation (Water moving from a liquid to a vapor state) 
• Condensation (Water moving from a vapor state to a liquid state) 
• Advection (The horizontal movement of the clouds) 
• Precipitation (Rain and snow) 
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Activity #3 (Creating the Content Slides) 
 

1. Create a single Bulleted Slide for each of the 5 topics above.  Type the topic name on each slide:  

Gravity, Solar Radiation, Evaporation etc.     

2. In the Bulleted Item area of each slide,  type Content Item 1, Content Item 2, etc. for each slide.   

3. When completed, you should have 5 slides and with 2 or 3 content items on each slide. 

 
 

 
Activity #4 (Linking the Menu to the Content) 
 

1. With your cursor, highlight the text that reads “Gravity” 

2. From the Slide Show Menu, select Action Settings. 

3. On the Action Settings dialogue box, select the Hyperlink to: radio button. 

4. From the drop-down menu, select Slide . . .   The Hyperlink to Slide dialogue box will appear. 

5. In the Hyperlink to Slide dialogue box, select the Gravity slide. 

6. Click OK. 

7. Switch to Slide Show view and test your new Hyperlink. 

8. Repeat the process for the other four slides.   

 
 

 
Activity #5 (Getting Back to the Menu Page) 
 

1. From the View menu, select Master >> Slide Master. 

2. From the Slide Show menu, select Action Buttons.  

3. From the Action Buttons options, select the Home button.  Note: Your cursor will change to a 

Plus sign. 
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4. With your cursor on the slide, click the mouse to place the Home button.  The Action Settings 

dialogue box will automatically open.   

5. In the Action Settings dialogue box, select the Hyperlink to: radio button.  Note: This may 

already be selected. 

6. In the Hyperlink to: drop-down menu, select Slide. 

7. In the Hyperlink to Slide dialogue box, select the The Hydrologic Cycle Components slide. 

8. Resize and position the button into the lower-right corner of the slide. 

9. Close your Master Slide. 

10. Switch to Slide Show view, and test. 

 
You have now created a hyperlinked, menu-driven system to display your material.  You can add as 
many slides to each content unit as necessary to convey your material effectively. 
 

 
 
4. Turn your “Listeners” into “Explorers” 
 
To further transition your materials away from the “Banking” Model of Education, you can capitalize on 
the Hyperlinked menu that you created in the previous exercises.  By transforming your statements into 
questions, you can push your material even further from the “telling” and actually have your 
students/listeners “seeking” the information.   
 
Integrating a PowerPoint based delivery with traditional classroom materials will increase the 
effectiveness of your activities.   
 
--View the Introduction to Poetry PowerPoint presentation. 
 

 
 
5. Beyond “Exploration” to “Activity” 
 
In this last exercise, we are going to utilize the same materials that we created in our Hyperlinked menu 
system and we are going to animate a graphical menu to replace (or suppliment) the text-based menu 
system.     
 
See the image below. 
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Activity #6 (Creating a Graphical Menu Page) 
 

1. Copy the folder titled advanced_files from the location noted by your instructor to your desktop.   

2. Create a Blank slide at the end of your presentation. 

3. Select Insert >> Picture >> From File. 

4. Select the file titled background.gif, and click Insert.  The picture will be placed on the 

blank slide. 

5. Using the handles in the corners of the image, stretch the image to fill the entire slide. 

6. Select Insert >> Picture >> From File. 

7. Select the file titled sun.gif, and click Insert.  The picture will be placed on top of the 

background. 

8. Move and resize the sun to the top right corner of the image. 

9. With the sun still selected, select Slide Show >> Action Settings . . .   

10. Select the Hyperlink to radio button, and from the drop-down menu, select Slide . . .  

11. From the menu, select the slide titled Solar Radiation.  Note: Be sure to select the name of the 

slide when you use the Hyperlink to Action Setting.  If you re-arrange the order of your slides, 

your Hyperlink will still work.  If you use any other method, they will not. 
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12. Repeat the process and connect the following elements with their content slide inside: 

• gravity-redarrow.gif with the slide titled Gravity 
• evaporation-arrows.gif with the slide titled Evaporation  
• condensation-raincloud.gif with the slide titled Condensation 
• oceanbreezes-raincloud.gif with the slide titled Advection  
• raining-raincloud.gif with the slide titled Precipitation 

 
Switch to Slide Show view to test your Hyperlinks.  If any of the Hyperlinks do not work, or go to the 
wrong slide, from the Graphical menu that you just created, select the element, right-click on your 
mouse (Command-click for Mac users), and from the contextual menu, select Action Settings to edit.   
 

 
 
Activity #7 (Getting Back to the Graphic and Text Menus) 
 

1. From the View menu, select Master >> Slide Master. 

2. Select the Action Button you created in Activity #4, and press the Delete key.   

3. Select Insert >> Picture >> From File. 

4. Select the file titled button_title_menu.jpg, and click Insert. 

5. Move and resize the button to the lower left corner of the image. 

6. With the button still selected, select Slide Show >> Action Settings . . .   

7. Select the Hyperlink to radio button, and from the drop-down menu, select Slide . . .  

8. From the menu, select your Text Menu slide.   

9. Select Insert >> Picture >> From File. 

10. Select the file titled button_graphic_menu.jpg, and click Insert. 

11. Move and resize the button to the lower right corner of the image. 

12. With the button still selected, select Slide Show >> Action Settings . . .   

13. Select the Hyperlink to radio button, and from the drop-down menu, select Slide . . .  

14. From the menu, select your Graphic Menu slide.   

15. Close your Master Slide. 

 
Switch to Slide Show view, and test.  Both the Graphics will appear on every slide in the presentation.  If 
any of the Hyperlinks do not work, or go to the wrong slide, return to the Slide Master, select the 
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element, right-click on your mouse (Command-click for Mac users), and from the contextual menu, 
select Action Settings to edit.   
 

 
 
Final Discussion 
 
Be prepared to discuss the following topics with your peers and instructor: 
 

• Do you feel that these skills are useful or not?  Why? 
• How can you incorporate other levels of interactivity using PowerPoint into your classroom or 

presentations? 
• Did you think of any other ways to add interaction to your presentations?  If so, be prepared to 

explain them?  
• What kind of resources are available to make similar presentations for my courses? 

Professor Marlon Nance of the Geology Department at CSU, Sacramento contributed time and 
expertise about the The Hydrologic Cycle Components for this Workshop. 


